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PREFACE 
 
This Instruction Manual contains basic matters such as installation and usage instructions in order to 
ensure optimal performance of “PC Setting Software for Electric Actuators S-Tools. Please read 
this Instruction Manual thoroughly and use the product properly. 
Keep this Instruction Manual in a safe place and be careful not to lose it. 

 
Product specifications and appearances presented in this Instruction Manual are subject to change 
without notice. 

 

• CKD has no warranty obligation whatsoever with respect to the information provided by this 
software, including the contents, accuracy, safety, merchantability, and compatibility for a 
particular use or purpose. 

• CKD Corporation shall not be responsible nor liable for any damage caused by this software. 
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SAFETY INFORMATION 
 
In order to use our products safely, it is important to select, use, handle, and maintain the products 
properly. 
Observe the warnings and precautions described in this Instruction Manual to ensure device safety. 
 
Although various safety measures have been adopted in the product, customer's improper handling 
may lead to an accident. To avoid this: 

Thoroughly read and understand this Instruction Manual before using the product. 

 
To explicitly indicate the severity and likelihood of a potential harm or damage, precautions are 
classified into three categories: “DANGER,” “WARNING,” and “CAUTION.” 
 

 DANGER 
Indicates an imminent hazard. Improper handling will cause death or serious 
injury to people. 

 WARNING 
Indicates a potential hazard. Improper handling may cause death or serious 
injury. 

 CAUTION 
Indicates a potential hazard. Improper handling may cause injury to people 
or damage to property. 

 
Note that some items indicated with “CAUTION” may lead to serious results depending on the 
conditions. 
All items contain important information and must be observed. 
 
The following icon is used to indicate other general precautions and usage hints. 
 

  Indicates a general precaution or usage hint. 
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1. PRODUCT OVERVIEW 
 

1.1 Operating Environment 

 

This software requires the following operating environment. 
 

Operating system 
(OS) 

Windows® 10 

Resolution 
Recommended: 1024 × 768 (XGA) or higher 
Required: 800 × 600 (SVGA) or higher 

USB port USB 2.0 compliant 

Others Microsoft .NET Framework 4.7.1 or later 

 

  
For the above OS, S-Tools can be used for both the 32-bit version and the 64-bit version. 
S-Tools runs in the desktop environment of Windows 10. 

 
 

1.2 Precautions for Use 

 
• Use a USB communication cable to communicate with the controller. For connecting the cable, refer 

to the Instruction Manuals for applicable actuator or controller. 
• Do not connect/disconnect the USB communication cable or turn ON/OFF the controller while 

sending/receiving data to/from the controller. This may cause the controller or S-Tools to malfunction. 
Exit S-Tools before connecting/disconnecting the connector or turning ON/OFF the power supply. 

• Do not set Windows to sleep mode (standby) while running S-Tools. This may cause a 
communication failure when returning from sleep mode. 

• If a communication error occurs, check the connection of the USB communication cable (such as 
whether there are any disconnections). 

• S-Tools is a setting software for following products. 

• ECR Series controller (a controller for EBS-M Series and other similar electric actuators) 

• ECG Series controller (a controller for EBS-G Series and other similar electric actuators) 

• FFLD Series electric actuators (the controller is built in) 

• This software cannot be used simultaneously with other communication software that uses the USB 
communication interface. Exit other communication software before using this software. 
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1.3 Screen Layout of S-Tools 

 
The S-Tools screen consists of following elements: 
 
 

 
 
 

No. Name Description 

(1) File tab It contains commands for managing files and performing print and print preview. 

(2) Ribbon tabs They represent the S-Tools function group. Selecting a tab switches the ribbon menu. 

(3) Ribbon menu It contains commands for selecting the function to be executed. 

(4) Window tabs 
They are for selecting the data to be worked on and are shown only when there are multiple 
windows. No tab is shown if there is only one window. 

(5) View It displays the area for using the selected function. 

(6) Equipment status panel It displays the status of each piece of equipment (PC, controller, and actuator). 

(7) Communication status bar It displays the controller communication status and the actuator model number. 

(8) Operation panel 
It contains commands for checking the operation of the electric actuator when online. There 
are 4 tabs. 

(9) Operation panel check box It opens/closes the operation panel. 

(10) Help button It shows the software version of S-Tools and the version information of the installed DLL. 

 

(6) (7) 

(4) (8) (3) (1) (2) (9) (10) (5) 
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1.4 Application Structure 

 
The figure below shows the functions that can be used with S-Tools. 
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1.5 Operation Modes of S-Tools 

 
The following functions and views can be used depending on the operation mode of S-Tools: 
 

Function, View 

Operation mode Note 1 

Remarks 
Online Offline 

Actuator 
unconnected 

Home 
Home A A A - 

Language A A A - 

Setting 

Disconnect A S A A message appears when offline. 

Display setting A N A 
A warning message appears if communication with 
the controller cannot be made. 

Actuator setting A S A 
Settings cannot be read, written, or initialized 
offline. 

CC-Link setting A S A Settings cannot be read or written offline. 

EtherCAT setting A S S Settings cannot be read or written offline. 

EtherNet/IP 
setting 

A S Y Settings cannot be read or written offline. 

Edit 

Point data A S N 
Point data cannot be read or written offline. 
Controller cannot be initialized offline. Position 
cannot be imported with the actuator unconnected. 

Parameters A S A 
Parameters cannot be read or written offline. 
Controller cannot be initialized offline. 

Monitoring 
and 
maintenance 

Speed waveform A S A Speed waveform cannot be monitored offline. 

Calendar A N A 
Calendar information cannot be read from or 
written to the controller offline. 

Alarm history A S A 
Alarm information cannot be read from the 
controller or initialized offline. 

Operation 
information 

A S A 
A warning message appears if communication with 
the controller cannot be made. 

Maintenance 
information 

A N S 
Maintenance information cannot be read from the 
controller offline. 

Model information A N A 
Model information cannot be read offline. Actuator 
information cannot be saved offline. 

Common 
features 

Operation panel A N A 
Panel cannot be operated offline. Alarms can be 
cleared, modes can be switched, and gains can be 
adjusted even with the actuator unconnected. 

Equipment status A A A 
Connection status is displayed in gray and the 
controller/actuator information is displayed as “***” 
when offline. 

Communication 
status 

A A A Only “Offline” is displayed when offline. 

Version 
information 

A A A - 

Note 1: A: All functions can be used, S: Some functions can be used, N No function can be used 
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2. INSTALLATION 
 

2.1 Obtaining the Installer 

 
The installer for S-Tools is available on CKD’s website (https://www.ckd.co.jp/). 
 
<How to obtain the installer> 

1 Click “COMPONENT PRODUCTS” from the “PRODUCT INFORMATION” tab or “PRODUCT 
INFORMATION” page. 
 

2 Click “Electric actuators” from the Product Category. 
 

3 Click “Stepper motor drive”. 
 

4 Access the “Controller ECR” details page from the Product List. 
* Other than the page for “ECR,” the installer can also be obtained from the product information 

page for a controller that uses S-Tools as the setting software. 
 

5 Click “Software” and download one of the following files that applies to the PC to use with S-Tools. 
 

OS File name 

32 bit PC Setting software S-Tools for Electric actuators (32 bit Ver*****).zip 

64 bit PC Setting software S-Tools for Electric actuators (64 bit Ver*****).zip 

* The version information of S-Tools is shown in *****. 
 

https://www.ckd.co.jp/
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2.2 Installation Procedure 

 

  To prevent a malfunction, exit all programs before starting the installation. 

 

1 Double-click on the “setup.exe” file to launch the installer. 
* If a confirmation massage that asks whether to install the program from an unknown publisher 

appears at the beginning of the installation, click [Yes] to continue the installation. 
 

2 If “.Net Framework 4.7.1” dialog box appears, click [Install]. 
It only appears on a PC that do not have “.Net Framework” version 4.7.1 or later installed. Clicking 
[Cancel] will abort the installation of S-Tools. 
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3 Once InstallShield Wizard has been prepared, “InstallShield Wizard Welcome” dialog box appears. 
Click [Next]. 
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4 Confirm the License Agreement. Select “I accept the terms in the license agreement” and click 
[Next] to accept the license agreement. Failure to accept the License Agreement will abort the 
installation. 

 

 
 

5 Input the customer information and click [Next]. 
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6 Ready to Install the Program dialog box appears. Click [Install] to begin installation. 
 

 
 

7 InstallShield Wizard Completed dialog box appears. Click [Finish] to close the dialog box. 
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3. USAGE 
 
Depending on the S-Tools version, some controllers cannot be connected and some functions are not 
available for use. Use the latest version of S-Tools. The following section lists the S-Tools versions 
compatible with the controllers to be used. 
 

Controller S-Tools version 

ECR Version 1.00.02.00 or later 

FFLD Version 1.02.00.00 or later 

ECG-A (parallel I/O specifications, CC-Link 
specifications) 

Version 1.03.00.00 or later 

ECG-A (parallel I/O specifications, CC-Link 
specifications) 

Version 1.04.00.00 or later 

ECG-B Version 1.04.00.00 or later 

 

  

• When adjusting the electric actuator using this software, make sure to read the Instruction 
Manual for the electric actuator and use it correctly. 

• At the adjustment stage, the actuator may move in an unexpected way. 
• Make sure there is no mechanical interference and stay away from the movable sections. 

 

3.1 Start and Exit 

 

3.1.1 Start 

 
To start S-Tools, go to the Windows Start Menu, select CKD Corporation, and then select S-Tools. 

New dialog box appears. For details on the “New” dialog box, refer to “3.2.2 New“. 

 
 

3.1.2 Exit 
 
To exit S-Tools, click the [X] button in the upper right corner of the window or open the File menu and 
click the [Exit the application] button. 
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3.2 File Tab 

 

3.2.1 Overview of the File tab 
 
The File tab contains commands for creating, saving, opening, closing, and printing a file. 
 
Selecting the File tab displays the following menu. 
 

 
 

Name Description Detail 

New It opens the New dialog box. 3.2.2 

Open It opens an existing file. 3.2.3 

Close It closes the active window tab. 3.2.3 

Save It overwrites and saves the file being edited. 3.2.4 

Save as It saves the file being edited with a name. 3.2.4 

Print 
It prints the currently displayed view. “Point data,” “Parameters,” and “Speed waveform” 
are the objects that can be printed and are printed as they appear in their respective view. 

- 

Print preview 
It shows the object as it will appear in printed form in the preview dialog box. “Point data” 
and “Parameters” are the objects that can be previewed. 

- 

Recent files 
It lists up to 10 recently used files (*.exal format) with the most recent first. Selecting a file 
opens it. 

- 

It exit the application Exits S-Tools. 3.2.4 

 
 
 
 



SM-A11147-A/5 3. USAGE 

 12 2021-01-13 

3.2.2 New 
 
Starting S-Tools or selecting [New] from the File tab opens the “New” dialog box. 
 

 
 

◼ Offline 

<From a new file> 
Selecting the items and clicking the [OK] button runs S-Tools without connecting to the controller. 
Clicking the [Cancel] button cancels “New” and if there are no other window tabs being edited, exits S-
Tools. If there are other window tabs being edited, the New dialog box closes. 
 
<By opening a file> 

Clicking the [Open a file] button opens the file selection dialog box. Opening a file closes the New dialog 

box. Not selecting a file in the file selection dialog box keeps the New dialog box open. Files in S-Tools 

format (*.exal) can be selected. 
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◼ Online 

The COM port that can be connected is displayed in the box labeled “Communication port selection.” If 
there is no connectable COM port, “-” is displayed. 
 
Selecting a COM port and clicking the [OK] button runs S-Tools after connecting to the controller. 
Clicking the [Cancel] button cancels “New” and if there are no other window tabs being edited, exits S-
Tools. If there are other window tabs being edited, the “New” dialog box closes. 
 
If the actuator is not connected, the confirmation message “Could not verify the actuator model number. 
Select the model number to continue bringing it online” appears. Clicking the [OK] button opens the 
model number selection dialog box. Selecting the model number and clicking the [OK] button brings the 
equipment online with the selected model number. Clicking the [Cancel] button cancels “New” and if 
there are no other window tabs being edited, exits S-Tools. If there are other window tabs being edited, 
the New dialog box closes. 
 
* The COM port to which the controller (such as ECR Series) is connected can be checked in “Ports 

(COM & LPT)” under the “Device Manager,” a standard Windows OS feature. Use the COM port 
indicated with “USB Serial Device” or “CDC USB Driver.” 

 

 
 
 



SM-A11147-A/5 3. USAGE 

 14 2021-01-13 

3.2.3 Open/Close 
 
<Open> 
Selecting [Open] opens the file selection dialog box. When a file is opened, it opens with the Home tab 
selected. 
Files in S-Tools format (*.exal) can be selected. 
 

 
 
<Close> 
Selecting [Close] closes the active window tab. If there is only one window tab, closing the window tab 
exits S-Tools. To exit S-Tools, refer to “3.2.4 Save/Exit.” 
 
If either “Point data,” “Parameters,” or “Speed waveform” is being edited, the confirmation message 
“Are you sure to save the change to Data1?” appears. The Data1 part will contain the window tab name 
(file name). 
 

 
 

Name Description 

Yes It closes the window tab after either “overwriting the file” or “saving the file with a name.” 

No It closes the window tab without saving the file. 

Cancel It closes the dialog box. 
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3.2.4 Save/Exit 
 
<Save> 
Selecting [Save] overwrites the file being edited. If the file has never been saved before, the same 
dialog box as “Save As” appears. 
 

Data saved in the file 

Point data Parameters 

Speed waveform Alarm history 

Maintenance information Model information 

CC-Link EtherCAT 

EtherNet/IP - 

 
<Save as> 
Selecting [Save as] saves the file being edited with a name. The default file name is date_Exal.exal 
(example: 201803141113_Exal.exal). If either “Point data,” “Parameters,” or “Speed waveform” is 
displayed, it can be saved in csv format. 
 

 
 
<Exit the application> 
Clicking the [Exit the application] button closes all window tabs and exits S-Tools. In the TOOL mode, 
the following dialog box appears. To close a window tab, refer to “3.2.3 Open/Close.” 
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3.3 Home Tab 

 

3.3.1 Overview of the Home tab 
 
The Home tab contains commands for managing windows, switching between functions, and changing 
the display language. 
 
Selecting the Home tab displays the following ribbon menu. 
 

 
 

Name Description Detail 

Home Starts the “Home” view. 3.3.2 

Restore initial size It restores the S-Tools window to its default size. - 

Window It is used to change the arrangement of windows when multiple window tabs are launched. 3.3.3 

Language It is used to change the display language. The change takes effect after restarting the PC. 3.3.4 

 
 

3.3.2 Home 
 
Clicking the [Home] button starts the following view. 
 

 
 

Name Description 

Set a communication port It shows the Setting tab and its ribbon when the icon or the button is clicked. 

Set a program and parameters It shows the Edit tab and its ribbon when the icon or the button is clicked. 

Acquire the waveform data It shows the Monitoring and maintenance tab and its ribbon when the icon or the button is clicked. 
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3.3.3 Window 
 
This function changes the arrangement of opened window tabs if multiple window tabs are being edited. 
 

 
 

Name Description 

Arrange windows vertically It displays the selected window tab on the lower side. 

Arrange windows 
horizontally 

It displays the selected window tab on the right side. 

Cascade It displays all window tabs together. This is the default arrangement. 

 

3.3.4 Language 
 
Clicking the [Language] button starts the “Language” view. It can also be used offline. 
 

 
 
The following confirmation dialog box appears after selecting the language to use and clicking the 
[Setting] button. 
 

 
 
The selected language takes effect after restarting S-Tools. 
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3.4 Setting Tab 

 

3.4.1 Overview of the Setting tab 
 
The Setting tab contains commands for configuring and displaying the network settings. 
 
Selecting the Settings tab displays the following ribbon menu. 
 

 
 

Name Description Detail 

Communication port It is used to select or update the communication port when online. 3.4.2 

Connect It connects the port selected in the communication port drop-down box. 3.4.3 

Disconnect It releases the port selected in the communication port drop-down box. 3.4.4 

Display setting It starts the “Display setting” view. 3.4.5 

Network It is used to configure CC-Link, EtherCAT or EtherNet/IP settings. 3.4.7 

 

  
Changes to the settings related to the parallel I/O and IO-Link specifications are made in the 
“Parameters” view started from the Edit tab. 

 
 

3.4.2 Communication port 
 
This function displays the communication port that can be connected. If there is no connectable 
communication port, “-” is displayed. Clicking the communication port drop-down box shows the 
connectable communication ports from which the communication port to use for connecting to the 
controller can be selected. 
 
Clicking the [Update] button updates the information of the connectable communication port. 
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3.4.3 Connect 
 
Clicking the [Connect] button connects the selected communication port to the controller. If the 
connection cannot be made, the message “The communication port could not be opened.” appears. If 
the port becomes unintentionally disconnected while in connection (other than by clicking the 
[Disconnect] button), it will reconnect automatically. 
 
If the actuator is not connected, the confirmation message “Could not verify the actuator model number. 
Do you want to continue and bring it online?” appears. Clicking the [OK] button connects the selected 
communication port to the controller. Clicking the [Cancel] button closes the dialog box. 
 
 

3.4.4 Disconnect 
 
Clicking the [Disconnect] button releases the currently connected communication port. It can be 
performed only when the port is open. 
 
If the [Disconnect] button is clicked when the port is closed, the message “The operation cannot be 
performed since the controller is not connected.” appears. 
 

 
 
If the [Disconnect] button is clicked when the controller is in the TOOL mode, the confirmation message 
“The PLC mode will be set. Are you sure? (Depending on the PLC setting, the actuator may perform an 
unexpected operation at mode switching.) ” appears. 
 

 
 
 

  

• When operating the actuator from an upper level equipment, set the controller to the PLC 
mode. In the TOOL mode, the controller does not accept operations from tan upper level 
equipment (such as PLC). 

• Before switching the controller to the PLC mode, check the input state of the signal from the 
upper level equipment to the controller. When the mode is switched from TOOL to PLC, the 
actuator may perform an unexpected operation depending on the setting of the upper level 
equipment. 
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3.4.5 Display setting 
 
Clicking the [Display setting] button starts the “Display setting” view. 
 

 
 
Clicking the [Update] button updates the set information. The information to be updated is as follows. 
 

Name Description 

Update date (PC time) It shows the PC date and time the [Update] button was clicked. 

Connection check 
It shows the status of the connection with the controller. 
It shows “OK” when there is connection and shows “-” when the connection is not established or there 
is no connection. 

COM port 
It shows the currently connected COM port. 
It shows “-” when the connection is not established or there is no connection. 

Controller model number 
It shows the model number of the connected controller. 
It shows “-” when the connection is not established or there is no connection. 

Interface specifications 
It shows the interface specifications of the connected controller. 
It shows “N/A” if it is other than “CC-Link,” “EtherCAT,” “EtherNet/IP,” “IO-Link,” or “PIO.” 
It shows “-” when the connection is not established or there is no connection. 

Controller serial number 
It shows the serial number of the connected controller. 
It shows “-” when the connection is not established or there is no connection. 

Actuator model number 
It shows the model number of the connected actuator. 
It shows “-” when the connection is not established or there is no connection. 

 
However, if the controller is not connected, the message “The operation cannot be performed since the 
controller is not connected.” appears. 
Also, if the model number of the connected actuator differs from the actuator model number shown in 
the selected window tab, the message “The operation cannot be performed since the model number of 
the actuator differs.” appears. 
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3.4.6 Actuator setting 
 
Clicking the [Actuator setting] button starts the “Actuator setting” view. Use this when setting the 
actuator information to the ECG-B Series controller. 
 

 
 

◼ Operating button 

 
 

Name Description 

Read 
It reads the actuator model number from the controller, and displays the actuator model number to the 
side of “Actuator model number (read data).” “No data” is displayed if any actuator information has not 
been written to the controller. Note 1, Note 2 

Write 

Writes the actuator information for the model number selected from the on-screen drop-down list. 
Note 1, Note 2 
The operation can only be performed in the TOOL mode and also when the actuator is in the servo 
OFF status. 
A confirmation message that asks whether to execute “software reset” appears after writing. 

Initialize This function initializes the actuator information that is written to the controller. Note 1, Note 2 

Note 1: If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

Note 2: If the actuator model number read from the controller differs from the actuator model number shown in the selected window tab, 
the message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  

• This screen can be used from the S-Tools version 1.04.00.00 or later. 
• The write function and initialize function can only be used when the ECG-B Series controller 

is connected. With other controllers, the actuator information is read from the actuator that is 
connected to the controller. 

• When executing a software reset, check the input state of the signal from the upper level 
equipment to the controller in advance. If a software reset is executed, the controller is 
started in the PLC mode. The actuator may perform an unexpected operation depending on 
the setting of the upper level equipment. 
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◼ Drop-down list 

Select the actuator model number to write to the ECG-B Series controller. Do not select other than the 
model number of the actuator that is to be used with connected to the controller. 
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3.4.7 Network 
 
Clicking the [Network] button shows the network submenu. 
 

 
 

Name Description 

CC-Link setting 
It can be selected when “CC-Link” is selected for the “Interface specifications” in the “Offline” section 
of the “New” dialog box or when the “Interface specifications” of the controller connected via Online 
section of the “New” dialog box is “CC-Link.” 

EtherCAT setting 
It can be selected when “EtherCAT” is selected for the “Interface specifications” in the “Offline” section 
of the “New” dialog box or when the “Interface specifications” of the controller connected via Online 
section of the “New” dialog box is “EtherCAT.” 

EtherNet/IP setting 
It can be selected when “EtherNet/IP” is selected for the “Interface specifications” in the “Offline” 
section of the “New” dialog box or when the “Interface specifications” of the controller connected via 
Online” section of the “New” dialog box is “EtherNet/IP.” 
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◼ CC-Link setting 

This view is for configuring the CC-Link settings. Clicking the [CC-Link setting] option under the network 
submenu starts the “CC-Link setting” view. 
 

 
 

Name Description 

［Read] button 
It shows the “Operation mode,” “Station number setting,” and “Baud rate setting” acquired from the 
controller. Note 1, Note 2 

[Write] button 
It loads the values specified for “Operation mode,” “Station number setting,” and “Baud rate setting” to 
the controller. Note 1, Note 2 
A confirmation message that asks whether to execute “software reset” appears after writing. 

Operation mode It sets the operation mode. The default value is “PIO.” 

Station number setting 
It sets the station number. The default value is “1.” However, the setting range depends on the 
operation mode. 

Baud rate setting It sets the baud rate. The default value is “156 kbps.” 

Note 1: If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” appears. 
Note 2: If the model number of the connected actuator differs from the actuator model number shown in the selected window tab, the 

message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  

When executing a software reset, check the input state of the signal from the upper level 
equipment to the controller in advance. If a software reset is executed, the controller is started 
in the PLC mode. The actuator may perform an unexpected operation depending on the 
setting of the upper level equipment. 
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◼ EtherCAT setting 

This view is for configuring the EtherCAT settings. Clicking the [EtherCAT setting] option under the 
network submenu starts the “EtherCAT setting” view. 
 

 
 

Name Description 

[Read] button 
It shows the “Operation mode,” “Device ID,” and “Device ID setting for Station Alias register” acquired 
from the controller. Note 1, Note 2 

[Write] button 
It loads the values specified for “Operation mode,” “Device ID,” and “Device ID setting for Station 
Alias register” to the controller. Note 1, Note 2 
A confirmation message that asks whether to execute “software reset” appears after writing. 

Operation mode It sets the operation mode. The default value is “PIO.” 

Device ID It sets the device ID. The default value is “1.” 

Device ID setting for Station 
Alias register 

It is selected to either “Set” or “Not set.” The default value is “Set.” 

Note 1: If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” appears. 
Note 2: If the model number of the connected actuator differs from the actuator model number shown in the selected window tab, the 

message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  

When executing a software reset, check the input state of the signal from the upper level 
equipment to the controller in advance. If a software reset is executed, the controller is started 
in the PLC mode. The actuator may perform an unexpected operation depending on the 
setting of the upper level equipment. 
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◼ EtherNet/IP setting 

This view is for configuring the EtherNet/IP settings. Clicking the [EtherNet/IP setting] option under the 
network submenu starts the “EtherNet/IP setting” view. 
 

 
 

Name Description 

［Read] button 
It displays the “Operation mode,” “IP address,” “Subnet mask,” “default gateway,” and “DHCP 
enabled/disabled” status. Note 1, Note 2 

[Write] button 
It loads the values specified for “Operation mode,” “IP address,” “Subnet mask,” “default gateway,” 
and “DHCP enabled/disabled” to the controller. Note 1, Note 2 
A confirmation message that asks whether to execute software reset appears after writing. 

Operation mode It sets the operation mode. The default value is “PIO.” 

IP address It sets the IP address. Set the address in the range from 0.0.0.0 to 255.255.255.255. 

Subnet mask It sets the subnet mask. Set in the range from 0.0.0.0 to 255.255.255.255. 

Default gateway It sets the default gateway. Set in the range from 0.0.0.0 to 255.255.255.255. 

DHCP server 
It is for selecting between “Disabled” and “Enabled.” When “Enabled” is selected, the IP address, 
subnet mask, and default gateway are assigned automatically from the DHCP server. 

Note 1: If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” appears. 
Note 2: If the actuator model number read from the controller differs from the actuator model number shown in the selected window tab, 

the message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  

• This screen can be used from the S-Tools version 1.04.00.00 or later. 
• When executing a software reset, check the input state of the signal from the upper level 

equipment to the controller in advance. If a software reset is executed, the controller is 
started in the PLC mode. The actuator may perform an unexpected operation depending on 
the setting of the upper level equipment. 
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3.5 Edit Tab 

 

3.5.1 Overview of the Edit tab 
 
The Edit tab contains commands for reading, writing, and editing the point data and parameters. 
 
Selecting the Edit tab displays the following ribbon menu. 
 

 
 

Name Description Detail 

Point data It starts the “Point data” view. 3.5.2 

Parameters It starts the “Parameters” view. 3.5.3 

Initialize editing data It initializes the editing data of Point data, Parameters, or both. 3.5.4 

Read It reads the data in Point data, Parameters, or both from the controller. 3.5.5 

Write It writes the editing data of Point data, Parameters, or both to the controller. 3.5.6 

Initialize controller It initializes the data in Point data, Parameters, or both stored in the controller. 3.5.7 
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3.5.2 Point data 
 
Clicking the [Point data] button starts the “Point data” view. For the setting range of the point data, refer 
to the Instruction Manual for the applicable controller. 
 
 
 

  
 
 
 

No. Name Description 

(1) Operating buttons They are buttons used for editing the Point data list. 

(2) Point data list It is a list of data on the points. 

(3) Page navigation 
It contains tools for flipping through the pages in the Point data list to be displayed on the 
screen. 

(4) Selected item input area It can be used to edit the setting of the item selected in the Point data list. 

(5) Description It is an area for displaying the description of the item selected in the Point data list. 

 

(1) (2) 

(3) (4) (5) 
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◼ Operating buttons 

 
 
Depending on the window width, the buttons may be hidden. Click the down arrow button to display 
items that do not fit within the display width. 
 

 
 
 
 
 
 

Name Description 

Undo 
It restores a value in a cell in the Point data list to its unedited value. Only the most recent unedited 
value can be restored. Editing a cell in the Point data list enables the [Undo] button. Restoring the 
unedited value disables the [Undo] button. 

Redo 
It restores a value in a cell in the Point data list to its edited value. Restoring the unedited value with 
the [Undo] button enables the [Redo] button. Restoring the edited value disables the [Redo] button. 

Import position 

It enters in the point data item selected the current position displayed on the operation panel. “Import 
position” can be performed when the controller is connected. “Position,” “Point zone (+),” and “Point 
zone (−)” are the items that can import position. “Import position” cannot be used when the actuator is 
unconnected. 

Copy row 
It copies the setting of the selected point data row. The copied data are retained until the window tab 
is closed, and multiple rows can be copied. The Comn row cannot be copied. 

Paste row 

It pastes information for the number of rows copied starting from the selected point data row. If the 
number of rows to paste to is less than the number of rows copied, paste will be performed for the 
number of rows in the pasting destination. Information in the copied rows that is outside the range of 
the pasting destination will not be pasted. Pasting cannot be performed to the Comn row. 

Initialize row 

It resets the setting of the row currently selected in the Point data list to its default value. Multiple rows 
can be selected and initialized. The general rows (No. 0 to No. 511) and the Comn row (at the top) 
can be initialized but a general row and the “Comn” row cannot be initialized at the same time. The 
general rows and the “Comn” row must be initialized separately when necessary. 

Travel time calculation 

It reflects the result of the calculation performed in the rows where calculation is possible to the 
[Travel time] column in the Point data list. Clicking the [Travel time calculation] button calculates the 
travel time of the point of the selected cell. Calculation is not possible if multiple rows are selected. If 
the Position specification method is set to “Absolute” and the start point is not set, the message 
“Please set the start point.” appears. 
The travel time is calculated assuming operation under specific conditions. The calculation result is 
for use as reference only. 

Pressing display 
It shows or hides the “Pressing rate,” “Pressing speed,” and “Pressing distance” columns in the Point 
data list. Putting a check in the box next to [Pressing display] shows those columns and unchecking 
the box hides them. The box is checked by default. 

Travel time display 
It shows or hides the “Travel time” and “Start point” columns in the Point data list. Putting a check in 
the box next to [Travel time display] shows those columns and unchecking the box hides them. The 
box is unchecked by default. 

Number of displayed items 
It changes the number of rows displayed in the Point data list. The default value is “10.” If the Number 
of displayed items is changed while displaying the second or a later page, the first page will be 
displayed. 
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◼ Point data list 

It always displays the common row (labeled Comn) in the first row. The row and column of the selected 
cell is highlighted. 
Initially, the points “No. 0” to “No. 9” are displayed. The points to be displayed can be switched with the 
page navigation buttons. 
 

 
 
The following items are displayed in the columns from the left. 

Position 
specification 

method 

Operation 
method 

Position 
[mm] ([deg]) 

Positioning width 
[mm] ([deg]) 

Speed [mm/s] 
([deg/s]) 

Acceleration 
[G] 

 

Deceleration 
[G] 

Acceleration/deceleration 
method Stop method Rotation 

direction 

Gain 
magnification 

[%] 

Point zone (+) 
[mm] ([deg]) 

 

Point zone (−) 
[mm] ([deg]) 

Pressing rate 
[%] 

Pressing speed 
[mm/s] ([deg/s]) 

Pressing 
distance [mm] 

([deg]) 
Start point 

Travel time 
[sec] 

 

  
• When converting [G] to [mm/s2] or [deg/s2] for acceleration and deceleration, assume 1G = 

9800 mm/s2 (deg/s2) for calculation. 
• Depending on the actuator, some items are not set and are therefore not displayed. 
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Position specification method 

This is the “Position” reference. 

Name Description 

Absolute It sets the “Position” of the point data to indicate the distance from the home position. 

Incremental It sets the “Position” of the point data to indicate the distance from the operation start position. 

Common value: None 
 
Operation method 

This is the operation performed when the motor stops. 

Name Description 

Positioning operation 
It outputs a point travel complete signal when the actuator reaches the positioning width with respect 
to the positioning completion point. When the positioning completion point is reached, the actuator 
stops. 

Pressing operation 1 
It outputs a point travel complete signal when the operation is performed at the force set by pressing 
rate for the set time in the pressing zone. When the pressing completion point is reached, the pressing 
operation ends and the actuator stops. 

Pressing operation 2 

It outputs a point travel complete signal when the actuator reaches the positioning width with respect 
to the pressing completion point and when the operation is performed with the force set by pressing 
rate as the maximum in the pressing zone. When the pressing completion point is reached, the pressing 
operation ends and the actuator stops. 

Common value: None 
 
Position [mm] ([deg]) 

The content of the setting depends on the setting of the “Operation method” as follows. 

Operation method Position [mm] ([deg]) 

Positioning operation This item is set to the final target position. 

Pressing operation 1 This item is set to the operation start position. 

Pressing operation 2 This item is set to the operation start position. 

Common value: None 
 
Positioning width [mm] ([deg]) 

The content of the setting depends on the setting of the “Operation method” as follows. 

Operation method Positioning width [mm] ([deg]) 

Positioning operation This item sets the output of the complete signal using the width (one side) relative to the final position. 

Pressing operation 1 This item is not reflected in pressing operation 1. 

Pressing operation 2 
This item sets the output of the complete signal using the width (one side) with respect to “Pressing 
start position + Pressing distance.” 

Common row: Value in the “Common positioning width” of the user parameter 
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Speed [mm/s] ([deg/s]) 

This is the travel speed for the constant speed zone during positioning operation. 

Common row: Value in the “Common speed” of the user parameter 
 
Acceleration [G] 

This is the acceleration speed for the acceleration zone during positioning operation. 

Common row: Value in the “Common acceleration speed” of the user parameter 
 
Deceleration [G] 

This is the deceleration speed for the deceleration zone during positioning operation. 

Common row: Value in the “Common deceleration speed” of the user parameter 
 
Acceleration/deceleration method 

This is how acceleration/deceleration is performed during positioning operation. 

Name Description 

Common 
It performs acceleration/deceleration according to the “Common acceleration/deceleration method” 
setting of the user parameter. 

Trapezoid It performs constant acceleration/deceleration at the set acceleration speed (deceleration speed). 

 
Stop method 

This is how a stop is performed during positioning operation. 

Name Description 

Common It performs stop operation according to the “Common stop method” setting of the user parameter. 

Control 
It performs position control to prevent the actuator from moving from the operation completion point 
after completing the operation. 

Fixed excitation 
It continuously applies holding current (its maximum being the set current) after completing the 
operation. 

Automatic servo OFF 1 
It applies holding current (its maximum being the set current) after completing the operation, and the 
servo turns OFF after the set waiting time has elapsed. 

Automatic servo OFF 2 
It applies holding current (its maximum being the set current) after completing the operation, and the 
servo turns OFF after the set waiting time has elapsed. 

Automatic servo OFF 3 
It applies holding current (its maximum being the set current) after completing the operation, and the 
servo turns OFF after the set waiting time has elapsed. 

 
Rotation direction 
This is the rotation direction. It is displayed only when a rotary type electric actuator is selected. 

Name Description 

Common It performs rotation according to the “Rotation direction” setting of the user parameter. 

Close rotation 
It rotates the actuator in the direction in which the distance of travel from the current position is short if 
the “Position” is set with “Absolute.” It rotates the actuator clockwise if the “Position” is set with 
“Incremental.” 

CW It rotates the actuator clockwise. 

CCW It rotates the actuator counterclockwise. 
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Gain magnification [%] 

This is used only when gain adjustment is required on a point-by-point basis. 

Common value: None 
Default value: 0 
 
Point zone (+) [mm] ([deg]) 

This is the limit for switching the point zone output signal from ON to OFF, indicated by the distance from 

the home position. 

Common value: None 

Default value: 0.00 mm (deg) 
 
Point zone (−) [mm] ([deg]) 

This is the limit for switching the point zone output signal from OFF to ON, indicated by the distance from 

the home position. 

Common value: None 

Default value: 0.00 mm (deg) 
 
Pressing rate [%] 

The content of the setting depends on the setting of the “Operation method” as follows. 

Operation method Pressing rate [%] 

Positioning operation This item is not reflected in the positioning operation. 

Pressing operation 1 
This item indicates the percentage based on maximum pressing force for judging the completion of 
pressing. 

Pressing operation 2 
This item indicates the maximum value of the percentage based on maximum pressing force for 
performing the pressing operation after the actuator reaches the pressing operation start position. 

Common row: “Common pressing rate” of the user parameter 
 
Pressing speed [mm/s] ([deg/s]) 

The content of the setting depends on the setting of the “Operation method” as follows. 

Operation method Pressing speed [mm/s] ([deg/s]) 

Positioning operation This item is not reflected in the positioning operation. 

Pressing operation 1 
This item indicates the speed for performing the pressing operation after the actuator reaches the 
pressing operation start position. 

Pressing operation 2 
This item indicates the speed for performing the pressing operation after the actuator reaches the 
pressing operation start position. 

Common row: “Common pressing speed” of the user parameter 
 
Pressing distance [mm] ([deg]) 

The content of the setting depends on the setting of the “Operation method” as follows. 

Operation method Pressing distance [mm] ([deg]) 

Positioning operation This item is not reflected in the positioning operation. 

Pressing operation 1 
This item indicates the pressing completion point and the distance for performing the pressing operation 
with “Position” + “Pressing distance.” 

Pressing operation 2 
This item indicates the pressing completion point and the distance for performing the pressing operation 
with “Position” + “Pressing distance.” 

Common row: “Common pressing distance” of the user parameter 
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Start point 

This is the point used as the start point when the travel time is calculated. The default value is blank. 

Setting range: 0 to 511 or 0 to 63 

Common value: None 
 
Travel time [sec] 

This is the result of the travel time calculation between the edit point and start point. The value cannot be 

input directly into the cell. 

Common value: None 
 

◼ Page navigation 

It contains tools for flipping through the pages in the Point data list. 
 
 

      
 

No. Description 

(1) It moves the list to the first page. It cannot be selected if the first page is displayed. 

(2) It moves the list to the previous page. It cannot be selected if the first page is displayed. 

(3) 
It shows the number of the currently displayed page in the list and the total number of pages. Entering a page number 
will move the list to that page. 

(3-1) It is the dialog box that appears if a page number outside the settable range is entered in the box next to Page. 

(4) It moves the list to the next page. It cannot be selected if the last page is displayed. 

(5) It moves the list to the last page. It cannot be selected if the last page is displayed. 

 

(1) (2) (3) (4) 

(3-1) 

(5) 
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◼ Selected item input area 

It shows the input area selected in the Point data list. Selecting the [Comn] radio button sets “0 (Comn)” 
in the cell selected in the Point data list. Entering “0” performs the same operation. The radio button 
cannot be selected for items with nothing in the “Comn” row (such as the Position specification 
method). 
 

 
 
 
 
 
 
The value that is input after selecting the [Direct input] radio button is reflected in the cell selected in the 
Point data list. Selecting the [Direct input] radio button changes the value in the cell from “0 (Comn)” to 
the default value. The value can be input directly without selecting the [Direct input] radio button. Values 
other than “0” are reflected in the selected cell. Entering “0” switches the value to “0 (Comn).” 
 

 
 
 
 
 

◼ Description 

It is an area for displaying the description of the item selected in the Point data list. 
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3.5.3 Parameters 
 
Clicking the [Parameters] button starts the “Parameters” view. For the default values of the parameters, 
refer to the Instruction Manual for the applicable controller. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 

(1) Operating button They are buttons used for editing the Parameters list. 

(2) Display group navigation 
They are buttons for switching between the item groups in the Parameters list to be 
displayed on the screen. 

(3) Parameters list It is a list of Parameters. 

(4) Description It is an area for displaying the description of the item selected in the Parameters list. 

 

(1) (2) 

(3) (4) 
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◼ Operating buttons 

 
 

Name Description 

Undo 
It restores a value in a cell in the Parameters list to its unedited value. Only the most recent unedited 
value can be restored. Editing a cell in the Parameters list enables the [Undo] button. Restoring the 
unedited value disables the [Undo] button. 

Redo 
It restores a value in a cell in the Parameters list to its edited value. Restoring the unedited value with 
the [Undo] button enables the [Redo] button. Restoring the edited value disables the [Redo] button. 

Import position 

It enters in the parameter selected the current position displayed on the operation panel. “Import 
position” can be performed when the controller is connected. “Soft Limit (+)/(−),” “Zone 1 (+)/(−),” and 
“Zone 2 (+)/(−)” are the items that can import position. “Import position” cannot be used when the 
actuator is unconnected. 

Initialize (item) 
It resets the setting of the row currently selected in the Parameters list to its default value. Multiple 
rows can be selected and initialized. Clicking the [Initialize (item)] button starts initialization. 

 

◼ Display group navigation 

They are buttons for switching between the parameter groups to be displayed on the screen. The 
parameters of the selected group are displayed in the Parameters list. Since the parameters cannot be 
edited for some groups, those parameters must be edited in the setting screen specified in the 
description of the item. 
 

 
 

Name Description 

Basic setting It displays the parameters related to the basic items of actuator operation. 

Point data setting It displays the parameters related to the values in the Comn row of the point data. 

Motor control setting It displays the parameters related to motor control. 

Interface setting It displays the parameters related to the network used with the controller. 

All items display It displays all the items in the Parameters list. 
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◼ Parameters list 

It displays a list of parameters corresponding to the controller. 
 

 
 

Name Description 

No. It shows the number given to the parameter. 

Item name It shows the item name of the parameter. 

Setting value It sets the value entered in the cell to the item. 

Unit It shows the unit of the item. 

 

◼ Description 

It is an area for displaying the Item name, Setting range, and Note for the item selected in the 
Parameters list. 
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3.5.4 Initialize editing data 
 
This function initializes the data being edited. 
 
If there are data being edited, the confirmation message “The data being edited will be lost. Are you 
sure?” appears. 
 

 
 

Name Description 

All data It resets the data in Point data and Parameters being edited to their default values. 

Point data only It resets the data in Point data being edited to their default values. 

Parameters only It resets the data in Parameters being edited to their default values. 

 
 

3.5.5 Read 
 
This function reads the data in Point data and Parameters from the controller for editing. The operation 
can only be performed in the TOOL mode. 
 
If there are data being edited, the confirmation message “The data being edited will be lost. Are you 
sure?” appears. 
 

 
 

Name Description 

All data It reads the Point data and Parameters from the connected controller for use as editing data. 

Point data only It reads the Point data from the connected controller for use as editing data. 

Parameters only It reads the Parameters from the connected controller for use as editing data. 
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3.5.6 Write 
 
This function writes the data in Point data and Parameters being edited to the controller. The operation 
can only be performed in the TOOL mode. 
 
Before writing the data to the controller, the confirmation message “The data in the controller will be 
overwritten. Are you sure?” appears. 
 
If the IO-Link master is connected, the confirmation message “Are you sure to transfer the data to the 
IO-Link master?” appears after writing the data to the controller. 
 

 
 

Name Description 

All data 
It writes the data in Point data and Parameters being edited to the controller. 
A confirmation message that asks whether to execute software reset appears after writing. 

Point data only It writes the data in Point data being edited to the controller. 

Parameters only 
It writes the data in Parameters being edited to the controller. 
A confirmation message that asks whether to execute software reset appears after writing. 

 

  

When executing a software reset, check the input state of the signal from the upper level 
equipment to the controller in advance. If a software reset is executed, the controller is started 
in the PLC mode. The actuator may perform an unexpected operation depending on the 
setting of the upper level equipment. 
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3.5.7 Initialize controller 
 
This function initializes the data in Point data and Parameters stored in the controller. The operation can 
only be performed in the TOOL mode. 
 
Before initializing the data, the confirmation message “The data in the controller will be initialized. Are 
you sure?” appears. 
 
If the IO-Link master is connected, the confirmation message “Are you sure to transfer the data to the 
IO-Link master?” appears after initializing the data in the controller. 
 

 
 

Name Description 

All data 
It initializes the Point data and Parameters stored in the connected controller. 
A confirmation message that asks whether to execute software reset appears after initializing. 

Point data only It initializes the Point data stored in the connected controller. 

Parameters only 
It initializes the Parameters stored in the connected controller. 
A confirmation message that asks whether to execute software reset appears after initializing. 

 

  

When executing a software reset, check the input state of the signal from the upper level 
equipment to the controller in advance. If a software reset is executed, the controller is started 
in the PLC mode. The actuator may perform an unexpected operation depending on the 
setting of the upper level equipment. 
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3.6 Monitoring and Maintenance Tab 

 

3.6.1 Overview of the Monitoring and maintenance tab 
 
The Monitoring and maintenance tab contains commands for displaying the speed waveform, calendar, 
alarm history, operation information, and maintenance information. 
 
Selecting the Monitoring and maintenance tab displays the following ribbon menu. 
 

 
 

Name Description Detail 

Speed waveform It starts the “Speed waveform” view. 3.6.2 

Calendar It starts the “Calendar” view. 3.6.3 

Alarm history It starts the “Alarm history” view. 3.6.4 

Operation information It starts the “Operation information” view. 3.6.5 

Maintenance information It starts the “Maintenance information” view. 3.6.6 

Model information It starts the “Model information” view. 3.6.7 
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3.6.2 Speed waveform 
 
Clicking the [Speed waveform] button starts the “Speed waveform” view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 

(1) Operating buttons 
They are for starting/stopping the acquisition of the speed waveform. Start cannot be 
executed if the actuator is unconnected. 

(2) Monitor status It displays the current monitor status. 

(3) 
Speed waveform display 
area 

It displays the acquired speed waveform. 

(4) Detailed setting button It allows the settings for acquiring and displaying the speed waveform to be made in detail. 

 
 

(1) (2) (4) (3) 
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◼ Operating buttons 

 
 

Name Description 

Start 

It starts acquiring the speed waveform. The [Start] button is selectable by default. If a waveform is 
displayed on the screen before acquiring the waveform, that waveform is cleared before starting 
acquisition. Clicking the [Start] button disables the [Start] button and editing of Detailed setting and 
enables the [Stop] button. Note 1, Note 2 

Stop 
It stops acquiring the speed waveform. The [Stop] button is not selectable by default but is enabled if 
monitoring is in progress. Clicking the [Stop] button disables it and enables editing of Detailed setting 
and the [Start] button. 

Note 1: If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” appears. 
Note 2: If the model number of the connected actuator differs from the actuator model number shown in the selected window tab, the 

message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

◼ Monitor status 

“Monitoring” is displayed when the speed waveform is being acquired. “Monitoring stop” is displayed 
when the speed waveform is not being acquired. 
 

◼ Speed waveform display area 

A speed waveform for 3 channels (Speed, Current, Position) is displayed. Opening a file in which a 
graph data (waveform data) is saved displays at once the waveforms that were displayed at the time 
the file was saved. Starting another view while the speed waveform is being acquired stops the 
acquisition of the speed waveform. If a communication error or alarm occurs while a speed waveform is 
being acquired, an error message appears and the monitoring process stops. When the process stops, 
the X-axis will be displayed at full scale. 
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◼ Detailed setting button 

Clicking the [Detailed setting] button opens the detailed setting panel as shown below. 
 

 
 
 
 

Name Description 

Enable selection 
It shows or hides each channel. Putting a check in the box shows the checked channel on the screen. 
Unchecking the box hides the unchecked channel. Each box is checked by default. 

Scale 
It is used to select the range, between the upper and lower limits of the Y-axis of each channel, to be 
displayed on the screen. The choices are “100,” “50,” “25,” “10,” “5,” and “1.” The waveform shown 
enlarges as the number decreases. The default value is “100.” 

Display maximum value 
It sets the limit of the Y-axis. The default value is “1000” for Speed, “300” for Position, and “250” for 
Current. 

Line color 
It sets the color used in the Y-axis. The default value is “black” for Speed, “green” for Position, and 
“blue” for Current. The choices are “black,” “green,” “blue,” “red,” “magenta,” “orange,” and “purple.” 

Measurement time 

It is used to select the measurement time of the speed waveform. The choices are “Not restricted,” 
“100,” “50,” “20,” “10,” “5,” “2,” and “1.” The default value is “Not restricted.” Measurement is stopped 
when the set measurement time has elapsed since the acquisition of the speed waveform started. If 
“Not restricted” is selected, the waveform measured for a maximum of 300 [sec] is stored. 

Time display maximum 
value 

It is used to select the limit of the X-axis. The choices are “20,” “10,” “5,” “2,” and “1.” The default 
value is “10.” 

Sampling Time It sets the sampling time. The default value is “100.” 

Display range of X-
axis/Scale operation area 

It allows the display area to be enlarged and the display range to be changed relative to the X-axis of 
the speed waveform. 

 

  

The waveform data are recorded only for 300 seconds. If a waveform is acquired for longer 
than 300 seconds, data that are older than the last 300 seconds will be deleted. 
<Example> 
If a waveform is acquired for 500 seconds, the data for 200th to 500th seconds are recorded. 

 
 

Position scale 100 Position scale 50 
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3.6.3 Calendar 
 
This function reads and writes the calendar information and displays the PC time. Clicking the 
[Calendar] button starts the “Calendar” view. The [Read] and [Write] buttons are grayed out and cannot 
be used except when the ECR Series is connected. 
 

 
 

◼ Operating buttons 

 
 

Name Description 

Read 
It reads and shows the calendar function setting, date, and time if the calendar function setting read 
from the controller is “Enabled.” If the calendar function is set to “Disabled,” the date and time are not 
updated. Note 1, Note 2 

Write 

It writes the date and time shown to the controller if the calendar function is set to “Enabled.” If it is set 
to “Disabled,” the date and time are not written. Note 1, Note 2 
The operation can only be performed in the TOOL mode. 
A confirmation message that asks whether to execute software reset appears after writing. 

Import PC time It imports the current PC date and time and shows them in the date and time area. 

Note 1:  If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

Note 2:  If the model number of the connected actuator differs from the actuator model number shown in the selected window tab, the 
message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  

• When the calendar function is disabled, the time since the controller power was turned ON is 
recorded at the time of an alarm occurrence (with both the ECG Series and FFLD Series, the 
calendar function is always set to Disabled). 

• By disabling the calendar function, the warning “Calendar initialize” and “Calendar write 
error” will no longer occur. 

• When executing a software reset, check the input state of the signal from the upper level 
equipment to the controller in advance. If a software reset is executed, the controller is 
started in the PLC mode. The actuator may perform an unexpected operation depending on 
the setting of the upper level equipment. 
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◼ Calendar function 

It is for setting the calendar function to “Enabled” or “Disabled.” “Disabled” is selected by default. 
 

 
 

◼ Date and time settings 

It displays the date on the left side and the time on the right side. The PC date and time the “Calendar” 
view was started are displayed by default. 
If the calendar function is set to “Disabled,” the calendar cannot be edited. 
 

 
 

Name Description 

Date 
It shows the date acquired from the controller or the date to be set in the controller. The date to be set 
can be selected from the pull-down menu or entered directly. 

Time 
It shows the time acquired from the controller or the time to be set in the controller. The time to be set 
can be changed by clicking the spin button on the right side or entered directly. 

 

  

If only the date and time settings are edited and written, the software reset does not have to be 
executed. 
The software reset must be executed only when the setting of the calendar function is 
changed. 
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3.6.4 Alarm history 
 
This function displays and initializes the alarm history recorded in the controller. Clicking the [Alarm 
history] button starts the “Alarm history” view. It can display up to 64 alarms and is not updated 
periodically. 
 
 
 

 
 
 
 
 

No. Name Description 

(1) Operating buttons 
They are for reading the alarm history, initializing the alarm history, and changing the 
number of rows shown per page. 

(2) Alarm history list It is a list of information on 64 alarms in order from the latest alarm occurrence. 

(3) Page navigation 
It contains tools for flipping through the pages in the Alarm history list to be displayed on 
the screen. 

 
 
 

(3) 

(2) (1) 
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◼ Operating buttons 

 
 

Name Description 

Read It acquires the Alarm history from the controller. Note 1, Note 2 

Initialize It initializes the Alarm history stored in the controller. Note 1, Note 2 

Number of displayed items 
It changes the number of rows of Alarm history shown per page. The choices are “10” to “60,” in 
increments of 10, and “All rows” (maximum of 64). The default value is “10.” 

Note 1:  If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

Note 2:  If the model number of the connected actuator differs from the actuator model number shown in the selected window tab, the 
message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

◼ Alarm history list 

It displays a list of alarms that have occurred. 
 

 
 

Name Description 

Code It shows the alarm code number. 

Item It shows the type of alarm. 

Phenomenon It shows the status of alarm occurrence. 

Cause/countermeasure It shows the cause of the alarm and the countermeasure. 

Occurrence time It shows the date and time the alarm occurred or the time elapsed since the controller was turned ON. 
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◼ Page navigation 

It contains tools for flipping through the pages in the Alarm history list. 
 
 

      
 

No. Description 

(1) It moves the list to the first page. It cannot be selected if the first page is displayed. 

(2) It moves the list to the previous page. It cannot be selected if the first page is displayed. 

(3) 
It shows the number of the currently displayed page in the alarm history list and the total number of pages. Entering a 
page number will move the list to that page. 

(3-1) It is the dialog box that appears if a page number outside the settable range is entered in the box next to Page. 

(4) It moves the list to the next page. It cannot be selected if the last page is displayed. 

(5) It moves the list to the last page. It cannot be selected if the last page is displayed. 

 
 
 

(1) (2) (3) (4) (5) 

(3-1) 
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3.6.5 Operation information 
 
Clicking the [Operation information] button shows the operation information submenu. 
 

  
 

Name Description 

Operation display 
It displays the input/output information between the PLC and controller which are related to the 
actuator operations. 

Monitor and data R/W display 
It displays the monitor value (position, speed, current, alarm) as well as the data reading/writing 
information between the PLC and controller. 
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◼ Operation display 

 
It displays the input/output information between the PLC and controller which are related to the actuator 
operations. Clicking the [Operation display] button under the operation information submenu starts the 
“Operation display” view. 
 
 
 

 
 

No. Name Description 

(1) Operating buttons It starts/stops the acquisition of the PLC input/output information. 

(2) Monitor status It displays the current monitor status. 

(3) Operation information list 
It displays the input/output signal information of the PLC acquired from the controller, which 
is related to the actuator operations. 

 
<Operating button> 

 
 

Name Description 

Start It starts acquiring input/output information. Note 1, Note 2 

Stop It stops acquiring input/output information. Clicking the [Start] button enables the [Stop] button. 

Note 1:  If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

Note 2:  If the actuator model number read from the controller differs from the actuator model number shown in the selected window 
tab, the message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  
Clicking either the [Start] button or the [Stop] button on the “Operation information” view in the 
TOOL mode turns OFF all the forced output signals. 
Make sure that it does not cause the upper level equipment to malfunction. 

 

(1) (2) (3) 
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<Monitor status> 
“Monitoring” is displayed when the operation information is being acquired. “Monitoring stop” is 
displayed when the operation information is not being acquired. 
 
<Operation information list> 
 

 
 

No. Name Description 

(1) Legend It shows the legend for ON/OFF. 

(2) TOOL/PLC mode It shows the current mode. 

(3) Operation mode It shows the current operation mode. 

(4) Input It shows the ON/OFF status of the current input signal. 

(5) Output It shows the ON/OFF status of the current output signal. 

(6) Forced output 
It is shown when the parallel I/O specifications controller is being used, and in the TOOL 
mode and in the Forced output mode. It is not shown in other cases. 
Clicking the [Switch] button switches the output ON/OFF. 

(7) Direct value input 
It shows the operation setting status when the controller other than with the parallel I/O 
specifications operates in the direct value travel. 

 

  
• The direct value input monitor can be used from the S-Tools version 1.04.00.00 or later. 
• The setting of direct value input can only be monitored when the ECG Series controller is 

used. 

 
  

(4) 

(1) (2) (3) 

(5) 

(6) 

(7) 
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◼ Monitor and data R/W display 

 
It displays the monitor value (position, speed, current, alarm) as well as the data reading/writing 
information between the PLC and controller. Clicking the [Monitor and data R/W display] button under 
the operation information submenu starts the “Monitor and data R/W display” view. 
 
 
 

 
 
 

No. Name Description 

(1) Operating buttons It starts/stops the acquisition of the PLC input/output information. 

(2) Monitor status It displays the current monitor status. 

(3) Operation information list 
It displays the information on communication with PLC (monitor value and data read/write 
information) acquired from the controller. 

 
<Operating button> 

 
 

Name Description 

Start It starts acquiring input/output information. Note 1, Note 2 

Stop It stops acquiring input/output information. Clicking the [Start] button enables the [Stop] button. 

Note 1:  If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” appears. 
Note 2:  If the actuator model number read from the controller differs from the actuator model number shown in the selected window 

tab, the message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  
• This screen can be used from the S-Tools version 1.04.00.00 or later. 
• This screen can only be used when the ECG Series is used. 

 
  

(1) (2) (3) 
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<Monitor status> 
“Monitoring” is displayed when the operation information is being acquired. “Monitoring stop” is 
displayed when the operation information is not being acquired. 
 
<Operation information list> 
 
 

 
 

No. Name Description 

(1) Legend It shows the legend for ON/OFF. 

(2) TOOL/PLC mode It shows the current mode. 

(3) Operation mode It shows the current operation mode. 

(4) Input It shows the ON/OFF status of the current input signal. 

(5) Output It shows the ON/OFF status of the current output signal. 

(6) Input (numeric value) It shows the input status of present numeric value data. 

(7) Output (numeric value) It shows the output status of the present numeric value data. 

(8) Display format Selects whether to display in hexadecimal or decimal number. 

 

  
When monitoring is started in the TOOL mode, the data cannot be read from the controller. 
Make sure to use in the PLC mode. 

 

(4) 

(1) (2) (3) 

(5) 

(6) 

(7) 

(8) 
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3.6.6 Maintenance information 
 
This function displays the maintenance information. Clicking the [Maintenance information] button starts 
the “Maintenance information” view. The maintenance data are updated only when the [Read] button is 
clicked and are not updated periodically. 
 
 
 

 
 

No. Name Description 

(1) Operating button It acquires maintenance information from the controller. 

(2) Maintenance information It shows information related to maintenance and allows changes to the threshold value. 

 

◼ Operating button 

 
 

Name Description 

[Read] button 
It acquires information other than the Changed value from the controller and displays them on the 
screen. Note 1, Note 2 

Note 1: If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

Note 2:  If the model number of the connected actuator differs from the actuator model number shown in the selected window tab, the 
message “The operation cannot be performed since the model number of the actuator differs.” appears. 

 

  

The maintenance data in the controller are updated every 10 minutes. If the controller is turned 
off before the data are updated, the data before the update are not saved. 
<Example> 
If the controller is turned off 125 minutes after it was turned on, first 120 minutes of changes in 
the maintenance data will be recorded but the last 5 minutes of changes in the maintenance 
data will not be saved. 

 
 
 

(1) (2) 
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◼ Maintenance information 

It contains information for performing “Initialize” and “Write” for “Integrated running distance,” 
“Integrated number of travel times,” and “Integrated operating time.” When the FFLD Series is selected, 
the [Initialize] and [Write] buttons for “Integrated running distance” are grayed out and cannot be used. 
 

 
 

Name Description 

Current value It shows the current value of each item. 

[Initialize] button 

It initializes the current value of each item. Note 1, Note 2 
Selecting [Yes] in the confirmation message “[Integrated running distance] in the controller will be 
initialized. Are you sure?” starts initialization. Initialization changes the value shown to “0.” The part 
[Integrated running distance] in the message is replaced by “Integrated running distance,” “Integrated 
number of travel times,” or “Integrated operating time” depending on the item initialized. 

Threshold value It shows the threshold value of each item. 

Changed value It is the box in which the value to change to is entered for the threshold value of each item. 

[Write] button It writes the Changed value of the Threshold value of each item to the controller. Note 1, Note 2 

Note 1:  If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

Note 2:  If the model number of the connected actuator differs from the actuator model number shown in the selected window tab, the 
message “The operation cannot be performed since the model number of the actuator differs.” appears. 
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3.6.7 Model Information 
 
This function displays the actuator information and controller information. Clicking the [Model 
information] button starts the “Model information” view. The data are updated only when the [Read] 
button is clicked and are not updated periodically. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 

(1) Operating button It acquires model information from the controller. 

(2) Actuator information It shows the actuator information. 

(3) Controller information It shows the controller information. 

 

◼ Operating button 

 
 

Name Description 

[Read] button 
It acquires “Actuator information” and “Controller information” from the controller and displays them on 
the screen. Note 1 

Note 1:  If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

 
 

(1) 
(2) 

(3) 
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◼ Actuator information 

The actuator information is for display only and cannot be input. 
 

 
 

Name Description 

Information of actuator 
connected last time 

It shows the model number of the previously connected actuator. 

Information of actuator 
being connected 

It shows the “model number” and the “software version” of the currently connected actuator. Note 1 

[Overwriting] button 

It saves the Information of actuator being connected over the Information of actuator connected last 
time. Note 2, Note 3 
The operation can only be performed in the TOOL mode. Note 4 
A confirmation message that asks whether to execute software reset appears after saving. 

Note 1:  EBS and EBR Series actuators do not have software versions. When an actuator without a software version is connected, 
Software ver. is blank. 

Note 2:  If the controller is not connected, the message “The operation cannot be performed since the controller is not connected.” 
appears. 

Note 3:  If the alarm code “0x1B03” or “0x3A03” has not occurred, the message “Since no corresponding alarm (0x1B03, 0x3A03) has 
occurred, the overwriting of actuator information cannot be performed.” appears. 

Note 4:  In the PLC mode, a message “The PLC mode is set. Set the TOOL mode.” appears. 

 

  

When executing a software reset, check the input state of the signal from the upper level 
equipment to the controller in advance. If a software reset is executed, the controller is started 
in the PLC mode. The actuator may perform an unexpected operation depending on the 
setting of the upper level equipment. 
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◼ Controller information 

The controller information is for display only and cannot be input. 
 

 
 

Name Description 

Model number It shows the model number of the controller. 

Serial number It shows the serial number of the controller. 

Software ver. It shows the main software ver. of the controller. 

Interface specifications 
It shows the internet specifications of the controller. 
It shows “N/A” if it is other than “CC-Link,” “EtherCAT,” “EtherNet/IP,” “IO-Link,” or “PIO.” 

Software ver. 
(Interface information) 

It shows the interface software ver. of the controller. 

 

  
There is no “Software ver.” for controllers of parallel I/O specifications. If a controller without 
“Software ver.” is connected, the display field for “Software ver.” is blank. 
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3.7 Common Features 

 

3.7.1 Overview of the common features 
 
Common features are those displayed separately from the view that is started by selecting a ribbon tab. 
Common features include the “Operation panel,” “Equipment status,” “Communication status,” and 
“Version information.” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Name Description Detail 

Operation panel 
It contains commands for checking the operation of the electric actuator when online. There 
are 4 tabs. 

3.7.2 

Equipment status panel It displays the status of each piece of equipment (PC, controller, and actuator). 3.7.3 

Communication status bar It displays the controller communication status and the actuator model number. 3.7.4 

Help button It shows the software version of S-Tools and the version information of the installed DLL. 3.7.5 
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3.7.2 Operation panel 
 
S-Tools starts with the operation panel open. S-Tools communicates with the controller and checks the 
operation of the electric actuator by jogging, inching, or operating a simple program. 
 
Clicking the part that is labeled [Operation panel Close] closes the operation panel and the label 
changes to [Operation panel Open]. Clicking the [Operation panel Open] label opens the operation 
panel. The same operation can be performed using the [Operation panel] check box in the upper right 
corner of the window. 
 
There are 3 tabs on the operation panel: “Operation 1” tab, “Operation 2” tab, “Adjust” tab, and “Adjust 
2” tab. The operation from these tabs is enabled when online. 
 
If the connection changes to offline while the actuator is being operated (such as jogging or inching), 
the process is interrupted and the message “A communication error has occurred.” appears. 
 
When the actuator is unconnected, only the [Alarm clear], [Mode switch], and [Gain adjustment] buttons 
on each tab can be used. 
 

 
 
 

No. Name Description 

(1) Operation panel check box It opens/closes the operation panel. 

(2) “Operation 1” tab It operates the actuator by selecting Jog or Inching. 

(3) “Operation 2” tab It operates the actuator by specifying the Point No. 

(4) “Adjust” tab It adjusts the actuator gain. 

(5) “Adjust 2” tab It adjusts the home position when the home position of the actuator is displaced. 

 

(1) 

(2) (3) (4) (5) 
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◼ Operation 1 

 

 
 

 

Name Description 

Current position 
It shows the current position of the movable section of the actuator as a numerical value. It is for 
display only and cannot be input. It shows “***” initially and when offline. It also shows “***” if home 
position return has not been executed for an actuator that requires home position return. 

Jog/Inching It is used to select the travel method for the movable section of the actuator. 

Speed 
It sets the travel speed for the movable section of the actuator. The setting range and the default 
value depend on the connected actuator. A warning message appears if a value outside the setting 
range is input. 

Inching distance 
It sets the inching distance for the movable section of the actuator. It cannot be input if “Jog” is 
selected as the travel method. The setting range is 0.10 to 10.00 [mm]. The default value is “0.10.” A 
warning message appears if a value outside the setting range is input. 

[− direction] button It moves the movable section of the actuator towards the motor. 

[+ direction] button It moves the movable section of the actuator in the direction opposite from the motor. 

[Stop] button It stops the movable section of the actuator that is moving. 

[Home position return] 
button 

It performs home position return. Upon completion of the home position return, a message that 
indicates completion appears. 

[Servo switch] button 

It switches the state of the servo from ON to OFF or OFF to ON. When switching from the servo OFF 
state, the confirmation message “The servo will be turned on. Are you sure?” appears. When 
switching from the servo ON state, the confirmation message “The servo will be turned off. Are you 
sure?” appears. Upon completion of the servo switch, a message that indicates completion appears. 

[Alarm clear] button It clears the alarm. 

[Mode switch] button 

It switches the mode to PLC or TOOL. When switching from the PLC mode, the confirmation 
message “The TOOL mode will be set. Are you sure?” appears. When switching from the TOOL 
mode, the confirmation message “The PLC mode will be set. Are you sure?” appears. Upon 
completion of the mode switch, a message that indicates completion appears. 

 

Enlarged 

Enlarged 
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<Actuator operation direction> 
When “Jog” is selected as the travel method, the movable section of the actuator moves while the [- 
direction] button or the [+ direction] button is held down. When “Inching” is selected as the travel 
method, clicking the [- direction] button or the [+ direction] button moves the movable section of the 
actuator by the distance set in “Inching distance.” Even if the [- direction] button or the [+ direction] 
button is clicked again when the inching operation has not been completed, the operation will not be 
accepted. 
 
For each button, the actuator moves in the direction as specified below. 

Button 
Series 

[- direction] [+ direction] 

EBS, EBR Direction of the motor Direction opposite from the motor 

FLSH, FFLD Finger opening direction Finger closing direction 

FLCR Direction opposite from the head Direction of the head 

FGRC CCW (counterclockwise) CW (clockwise) 

 
<Required states> 
For the buttons to function, the following states are required: 

State 
Button 

TOOL mode Note 1 No alarm Note 2 Servo ON Note 3 Home position Note 4 

[- direction] Required Required Required Required 

[+ direction] Required Required Required Required 

[Home position return] Required Required Required - 

[Servo switch] Required Required - - 

[Alarm clear] Required - - - 

Note 1:  In the PLC mode, a message “The PLC mode is set. Set the TOOL mode.” appears. 
Note 2:  If there is an alarm, the message “An alarm has occurred. Clear the alarm.” appears. 
Note 3:  In the servo OFF state, the message “The servo is OFF. Turn ON the servo.” appears. 
Note 4:  If the actuator is not in the home position, the message “The home position has not been detected. Perform home position 

return.” appears. 

 

  
Switching to the TOOL mode turns OFF all the output signals of parallel I/O. 
Make sure that it does not cause the upper level equipment to malfunction. 

 
<If alarm code “1B03” or “3A03” has occurred> 
The message “The alarm for a model number mismatch (1B03, 3A03) has occurred. Reconnect the 
actuator connected last time to the controller or overwrite the information of the actuator being 
connected with the information of the actuator connected last time on the model information screen.” 
appears. 
Depending on the alarm code, the confirmation message “It is an alarm that requests the power to be 
switched on again after the alarm occurrence cause is eliminated. Are you sure to perform a software 
reset?” appears. 
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◼ Operation 2 

This operation moves the movable section of the actuator by running a program that combines specified 
points. 
 

 

 
 
 

Name Description 

Current position It is the same as the Current position of Operation 1. For details, refer to “Operation 1.” 

Point No. 
It is a box for entering the Point No. for which the operation is checked. The Point No. that can be 
entered is “0” to “511” or “0” to “63.” The default is blank. If the box is blank, the next point travel is 
started. 

Waiting time 
It is a box for setting the time to wait for point travel to start. The setting range is “0” to “999” [sec]. 
The default value is “0.” Clicking the spin button increases or decreases the value in the box by ±1. 

Repeat 

It is a check box for specifying repetition of the point travel set in “Point No.” The box is unchecked by 
default. Pressing the [Execute] button after putting a check repeats the set point travel. The check 
box is disabled while the actuator is in operation. Pressing the [Stop] button interrupts the repeat 
process. 

[Next] button It starts the next point travel and is only enabled while the actuator is in operation. 

[Execute] button 
It starts point travel from the current position in the order the points are set in “Point No.” If an alarm 
occurs while the program is running, the message “An alarm has occurred.” appears. 
Required states: Servo ON and home position Note 1, Note 2 

[Stop] button It stops the movable section of the actuator that is performing point travel. 

Note 1:  In the servo OFF state, the message “The servo is OFF. Turn ON the servo.” appears. 
Note 2:  If the actuator is not in the home position, the message “The home position has not been detected. Perform home position 

return.” appears. 

 

  
Switching to the TOOL mode turns OFF all the output signals of parallel I/O. 
Make sure that it does not cause the upper level equipment to malfunction. 

 

Name Description 

[Home position return] 
button 

It is the same as the [Home position return] button of 
"Operation 1". For details, refer to "Operation 1". 

[Servo switch] button 
It is the same as the [Servo switch] button of "Operation 1". 
For details, refer to "Operation 1". 

[Alarm clear] button 
It is the same as the [Alarm clear] button of " Operation 1". 
For details, refer to "Operation 1". 

[Mode switch] button 
It is the same as the [Mode switch] button of "Operation 1". 
For details, refer to "Operation 1". 

While the program is running, the 
background of the Point No. currently being 
executed is displayed in light blue. 
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◼ Adjust 

This operation reads and writes the “Responsiveness” and “Load magnification” from and to the 
controller. 
 

 

 
 

Name Description 

Responsiveness - Read 
value 

It shows the value set for responsiveness. 
It shows “***” initially and when offline. 

Responsiveness - Write 
value 

It sets the value entered in the box to responsiveness. 
The default value is “0.” 

Load magnification - Read 
value 

It shows the value set for load magnification. 
It shows “***” initially and when offline. 

Load magnification - Write 
value 

It sets the value entered in the box to load magnification. 
The default value is “0.” 

[Read] button 
It reads the responsiveness and load magnification values from the controller. 
The operation can only be performed in the TOOL mode. Note 1 

[Write] button 
It writes the values in Write value boxes of responsiveness and load magnification to the controller. 
The operation can only be performed in the TOOL mode. Note 1 

[Shipment value 
incorporation] button 

It reads the responsiveness and load magnification values at shipment from the controller and shows 
them in the Write value boxes. 
The operation can only be performed in the TOOL mode. Note 1 

[Mode switch] button It is the same as the [Mode switch] button of Operation 1. For details, refer to “Operation 1.” 

Note 1:  In the PLC mode, a message “The PLC mode is set. Set the TOOL mode.” appears. 

 

  
Switching to the TOOL mode turns OFF all the output signals of parallel I/O. 
Make sure that it does not cause the upper level equipment to malfunction. 
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3.7.3 Equipment status 
 
This function displays the connection status of the PC, controller, and actuator as an image. 
 
When the equipment status panel is open, the header for opening/closing the panel shows “Equipment 
status Close.” When the equipment status panel is closed, the header for opening/closing the panel 
shows “Equipment status Open.” 
 
 

  
 
 
 

No. Name Description 

(1) 
Connection status between 
PC and controller 

It is shown in green when they are connected. It is shown in gray when they are not 
connected. 

(2) 
Connection status between 
controller and actuator 

It is shown in green when they are connected. It is shown in gray when they are not 
connected. 

(3) Actuator travel status 
It shows the current position of the actuator as an image. The image size of the actuator 
remains the same even if the actual size of the actuator changes. 

(4) Controller information It shows the “Model number” and “Interface specifications” from the controller information. 

(5) Actuator information It shows the “Model No.,” “Lead,” and “Stroke” from the actuator information. 

(6) Movable range display 
It shows the movable range of the actuator with numerical values and arrows. The range 
shown changes according to the changes in the setting of the parameters. 

(7) Legend It shows the legend used for the movable range. 

 
 
 
 
 
 

(2) (1) (3) (5) 

(7) (6) (4) 
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3.7.4 Communication status 
 
The communication status information is updated periodically. However, when the “Read,” “Write,” and 
“Initialize controller” buttons on the Edit tab are being processed, all items except “Port connection 
condition” are blank and will not be updated periodically. 
The details of the communication status are as follows. 
 
When connected to the controller 

 
 
 
When not connected to the controller 

 
 
 

No. Name Description 

(1) Port connection status 

It shows “Online” to indicate equipment is online when the port is opened and connected 
to the controller. 
It shows “Offline” to indicate equipment is offline when the port is closed. 

  

(2) TOOL/PLC status 

Online, it shows “TOOL mode” when the controller is in the TOOL mode. It shows “PLC 
mode” when the controller is in the PLC mode. 
Offline, it shows nothing. 

  

(3) Emergency stop status 

Online, it shows “Emergency stop operated” when the emergency stop is activated. It 
shows “Emergency stop not operated” when the emergency stop is not activated. 
Offline, it shows nothing. 

  

(4) Servo ON/OFF status 

Online, it shows “Servo ON” when the servo is turned on. It shows “Servo OFF” when the 
servo is turned off. 
Offline, it shows nothing. 

  

(5) Home position return status 

Online, it shows “Home position return complete” when the actuator has completed home 
position return. It shows “Home position return incomplete” when the actuator has not 
completed home position return. 
Offline, it shows nothing. 

  

(6) Warning status 

Online, it shows “Warning” when there is a warning. It shows “No warning” when there is 
no warning. 
Offline, it shows nothing. 

  

(7) Alarm status 

Online, it shows “Alarm” when there is an alarm. It shows “No alarm” when there is no 
alarm. 
Offline, it shows nothing. 

  

(8) Alarm number 
Online, it shows an alarm number when there is an alarm or a warning. It shows “0000” 
when there is no alarm or warning. 
Offline, it shows nothing. 

(9) Actuator model number 

Online, it shows the actuator model number in blue when the model number of the 
connected actuator is the same as the actuator model number on the window tab. It 
shows the actuator model number in red when they differ. Offline, it shows the actuator 
model number selected in the New dialog box in black. 

 

(1) 

(1) (2) (3) (4) (5) (6) (7) (8) (9) 
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3.7.5 Version information 
 
Clicking the [Help] button at the far right end of the ribbon opens the Version information dialog box. 
It shows the S-Tools version information and the version of the DLL used. 
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4. TROUBLESHOOTING 
 

4.1 Problems, Causes, and Solutions 

 
If a communication error occurs between S-Tools and the connected controller, check the table below for 
a possible solution. 
 

Message Cause Solution 

A communication error has occurred. 
Controller does not respond correctly 
to a command from S-Tools. 

Check that there is no problem in the 
connection of the USB cable. 

Check that the controller power is ON. 

A timeout error has occurred. 

Controller does not provide operation 
results correctly in response to a 
command from S-Tools even after 
certain period of time has elapsed. 

Check that there is no alarm. 

Check that the command sent from S-Tools 
just before the message appeared has been 
executed by the controller. 
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5. REFERENCE MATERIALS 
 

5.1 List of Shortcut Keys 

 

Function Item Description Shortcut Key tip 

File 

 Leaves the File menu selected. - Alt + F 

New Opens the New dialog box. Ctrl + N Alt + F + N 

Open Opens an existing file. Ctrl + O Alt + F + O 

Close Closes the active window tab. - Alt + F + C 

Save Overwrites and saves the file being edited. Ctrl + S Alt + F + S 

Save as Saves the file being edited with a name. - Alt + F + A 

Print Prints the file being edited. Ctrl + P Alt + F + P 

Print preview 
Shows an image of the printed output of the 
file being edited. 

- Alt + F + V 

Recent files Lists recently used files. - - 

Exit the application Exits S-Tools. - Alt + F + X 

Home 

Home Starts the “Home” view. - Alt + H + H 

Restore initial size Restores the window to its default size. - Alt + H + R 

Window 

Arrange 
windows 
vertically 

Displays multiple window tabs stacked 
vertically. 

- Alt + H + WA + O 

Arrange 
windows 
horizontally 

Displays multiple window tabs side by side. - Alt + H + WA + V 

Cascade 
Displays multiple window tabs overlapping 
one another. 

- Alt + H + WA + C 

Language Starts the “Language” view. - Alt + H + L 

Setting 

Update Updates connectable communication ports. - Alt + S + U 

Connect 
Connects a connectable communication port 
to the controller. 

- Alt + S + C 

Disconnect Releases the connected communication port. - Alt + S + D 

Display setting Starts the “Display setting” view. - Alt + S + V 

Actuator setting Starts the “Actuator setting” view. - Alt + S + A 

Network 

CC-Link setting Starts the “CC-Link setting” view. - Alt + S + F + FC 

EtherCAT 
setting 

Starts the “EtherCAT setting” view. - Alt + S + F + FE 

EtherNet/IP 
setting 

Starts the “EtherNet/IP setting” view. - Alt + S + F + FN 
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Function Item Description Shortcut Key tip 

Edit 

Point 
data 

- Starts the “Point data” view. - Alt + E + PO 

Undo Restores unedited value. Alt + U - 

Redo Restores edited value. Alt + R - 

Import position 
Imports data on the current position from the 
controller. 

Alt + G - 

Copy row 
Copies row by row (multiple rows can be 
copied). 

Alt + C - 

Paste row 
Pastes information for the number of rows 
copied. 

Alt + Q - 

Initialize row 
Initializes row by row (multiple rows can be 
selected). 

Alt + I - 

Travel time 
calculation 

Calculates the travel time based on the value 
in the cells. 

Alt + V - 

Pressing 
display 

Shows or hides the Pressing rate, Pressing 
speed, and Pressing distance columns. 

Alt + O - 

Travel time 
display 

Shows or hides the Travel time and Start point 
columns. 

Alt + T - 

Parameters 

- Starts the “Parameters” view. - Alt + E + PA 

Undo Restores unedited value. Alt + U - 

Redo Restores edited value. Alt + R - 

Import position 
Imports data on the current position from the 
controller. 

Alt + G - 

Initialize 
editing data 

All data 
Initializes both the Point data and the 
Parameters. 

- Alt + E + C + A 

Point data only Initializes only the Point data. - Alt + E + C + P 

Parameters 
only 

Initializes only the Parameters. - Alt + E + C + R 

Read 

All data 
Reads both the Point data and the 
Parameters from the controller. 

- Alt + E + G + A 

Point data only Reads only the Point data from the controller. - Alt + E + G + P 

Parameters 
only 

Reads only the Parameters from the 
controller. 

- Alt + E + G + R 

Write 

All data 
Writes both the Point data and the 
Parameters to the controller. 

- Alt + E + S + A 

Point data only Writes only the Point data to the controller. - Alt + E + S + P 

Parameters 
only 

Writes only the Parameters to the controller. - Alt + E + S + R 

Initialize 
controller 

All data 
Initializes both the Point data and the 
Parameters stored in the controller. 

- Alt + E + L + A 

Point data only 
Initializes only the Point data stored in the 
controller. 

- Alt + E + L + P 

Parameters 
only 

Initializes only the Parameters stored in the 
controller. 

- Alt + E + L + R 
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Function Item Description Shortcut Key tip 

Monitoring 
and 
maintenance 

Speed waveform Starts the “Speed waveform” view. - Alt + M + S 

Calendar Starts the “Calendar” view. - Alt + M + C 

Alarm history Starts the “Alarm history” view. - Alt + M + H 

Operation 
information 

Operation 
display 

Starts the “Operation display” view. - Alt + M + F+FC 

Monitor & data 
R/W display 

Starts the “Monitor & data R/W display” view. - Alt + M + F+FE 

Maintenance information Starts the “Maintenance information” view. - Alt + M + M 

Model information Starts the “Model information” view. - Alt + M + I 

Common 

Operation panel Opens/closes the operation panel. - Alt + P 

Operation 1 

Home position 
return 

Performs home position return of the servo. Alt + F - 

Servo switch Switches the servo. Alt + S - 

Alarm clear Clears an alarm. Alt + E - 

Mode switch Switches the mode. Alt + B - 

Operation 2 

Home position 
return 

Performs home position return of the servo. Alt + F - 

Servo switch Switches the servo. Alt + S - 

Alarm clear Clears an alarm. Alt + E - 

Mode switch Switches the mode. Alt + B - 

Adjust Mode switch Switches the mode. Alt + B  

 
 
 



SM-A11147-A/5 5. REFERENCE MATERIALS 

 74 2021-01-13 

5.2 Using the CSV File (Speed Waveform) 

 
On the speed waveform screen, selecting to save the data in csv format with “Save as” saves the data 
as shown in the figure below. “No.” in column A indicates the data number; and to determine the time axis, 
it is necessary to calculate the product of the values in the “No.” and “Sampling time” cells. 
 

 
 

 
 
“IO” in column E indicates the operation information for each time and indicates whether the input signals 
and the output signals are ON or OFF with an 8-digit number. The method for checking the ON/OFF for 
each signal is as follows. 
 

  
Signals are stored in “IO” only when the interface specifications is parallel I/O. For other 
interface specifications, 0 is output in “IO.” 

 
 
 
 
 

Input signals Output signals 
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◼ Check method for input signals 

Signal Check method 

Input 15 ON when the integer part of the value obtained by dividing the 8th digit (hex) by 8 is 1, and OFF when it is 0. 

Input 14 
ON when the integer part of the value obtained by dividing the 8th digit (hex) by 4 is odd, and OFF when it is 
even. 

Input 13 
ON when the integer part of the value obtained by dividing the 8th digit (hex) by 2 is odd, and OFF when it is 
even. 

Input 12 ON when the 8th digit (hex) is odd, and OFF when it is even. 

Input 11 ON when the integer part of the value obtained by dividing the 7th digit (hex) by 8 is 1, and OFF when it is 0. 

Input 10 
ON when the integer part of the value obtained by dividing the 7th digit (hex) by 4 is odd, and OFF when it is 
even. 

Input 9 
ON when the integer part of the value obtained by dividing the 7th digit (hex) by 2 is odd, and OFF when it is 
even. 

Input 8 ON when the 7th digit (hex) is odd, and OFF when it is even. 

Input 7 ON when the integer part of the value obtained by dividing the 6th digit (hex) by 8 is 1, and OFF when it is 0. 

Input 6 
ON when the integer part of the value obtained by dividing the 6th digit (hex) by 4 is odd, and OFF when it is 
even. 

Input 5 
ON when the integer part of the value obtained by dividing the 6th digit (hex) by 2 is odd, and OFF when it is 
even. 

Input 4 ON when the 6th digit (hex) is odd, and OFF when it is even. 

Input 3 ON when the integer part of the value obtained by dividing the 5th digit (hex) by 8 is 1, and OFF when it is 0. 

Input 2 
ON when the integer part of the value obtained by dividing the 5th digit (hex) by 4 is odd, and OFF when it is 
even. 

Input 1 
ON when the integer part of the value obtained by dividing the 5th digit (hex) by 2 is odd, and OFF when it is 
even. 

Input 0 ON when the 5th digit (hex) is odd, and OFF when it is even. 

 

◼ Check method for output signals 

Signal Check method 

Output 15 ON when the integer part of the value obtained by dividing the 4th digit (hex) by 8 is 1, and OFF when it is 0. 

Output 14 
ON when the integer part of the value obtained by dividing the 4th digit (hex) by 4 is odd, and OFF when it is 
even. 

Output 13 
ON when the integer part of the value obtained by dividing the 4th digit (hex) by 2 is odd, and OFF when it is 
even. 

Output 12 ON when the 4th digit (hex) is odd, and OFF when it is even. 

Output 11 ON when the integer part of the value obtained by dividing the 3rd digit (hex) by 8 is 1, and OFF when it is 0. 

Output 10 
ON when the integer part of the value obtained by dividing the 3rd digit (hex) by 4 is odd, and OFF when it is 
even. 

Output 9 
ON when the integer part of the value obtained by dividing the 3rd digit (hex) by 2 is odd, and OFF when it is 
even. 

Output 8 ON when the 3rd digit (hex) is odd, and OFF when it is even. 

Output 7 ON when the integer part of the value obtained by dividing the 2nd digit (hex) by 8 is 1, and OFF when it is 0. 

Output 6 
ON when the integer part of the value obtained by dividing the 2nd digit (hex) by 4 is odd, and OFF when it is 
even. 

Output 5 
ON when the integer part of the value obtained by dividing the 2nd digit (hex) by 2 is odd, and OFF when it is 
even. 

Output 4 ON when the 2nd digit (hex) is odd, and OFF when it is even. 

Output 3 ON when the integer part of the value obtained by dividing the 1st digit (hex) by 8 is 1, and OFF when it is 0. 

Output 2 
ON when the integer part of the value obtained by dividing the 1st digit (hex) by 4 is odd, and OFF when it is 
even. 

Output 1 
ON when the integer part of the value obtained by dividing the 1st digit (hex) by 2 is odd, and OFF when it is 
even. 

Output 0 ON when the 1st digit (hex) is odd, and OFF when it is even. 
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